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1. Introduction

1. Introduction
Thank you for purchasing Decagon Devices’ ProCheck.
The ProCheck is a device used to interface with your analog
and digital soil moisture sensors and obtain instantaneous
results. This manual will help you understand the functions
of and get the most out of your ProCheck device.

Customer Service &Tech Support
When contacting us via fax or E-mail, include your
ProCheck serial number and firmware version, name, address, phone numbers, and a description of your problem.

Contact Information
PHONE:
United States/Canada (Toll Free) 1-800-755-2751.
Outside of the U.S./Canada: 1-509-332-2756.
FAX: 1-509-332-5158
E-Mail: soils@decagon.com
You can also send feedback to Decagon using ECH2O Utility “Send Feedback to Decagon” feature. See Appendix B
for more information.

Warranty
The ProCheck is covered by a standard, one-year warranty
on parts and labor, and is activated upon the arrival of the
instrument at your location.
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Repair Instructions
If your ProCheck should ever require a repair, call Decagon
at (509)-332-2756 or 1-800-755-2751 (United States and
Canada). We will ask you for your address, phone number,
and your ProCheck serial number. For non-warranty repairs, we will also ask for your method of payment.
Before shipping your instrument to Decagon, please
contact Decagon to obtain a Return Merchandise Authorization number (RMA). This will allow Decagon’s repair staff to keep track of your ProCheck. Once you have
acquired an RMA, send your ProCheck to Decagon. Please
include a document listing the complete shipping address,
name, and department of the person responsible for the
instrument, as well as a description of the problem. This
will better help our technicians and shipping department
to expedite repair on your ProCheck, and ship it back to
you.
Please pack your ProCheck carefully. Ship it back in the
carrying case, preferably inside a cardboard box. Ship to:
Decagon Devices, Inc.
2365 NE Hopkins Court
Pullman, WA 99163

Repair Costs
Manufacturer’s defects and instruments under warranty
will be repaired at no cost. For non-warranty repairs, costs
for parts, labor, and shipping will be billed to you.
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Seller’s Liability
Seller warrants new equipment of its own manufacture
against defective workmanship and materials for a period
of one year from the date of receipt of equipment (the results of ordinary wear and tear, neglect, misuse, accident
and excessive deterioration due to corrosion from any cause
are not considered to be a defect); but Seller’s liability for
defective parts shall, in no event, exceed the furnishing of
replacement parts f.o.b. the factory where originally manufactured. Material and equipment covered hereby which is
not manufactured by the Seller shall be covered only by
the warranty of its manufacturer. Seller shall not be liable
to Buyer for loss, damage, or injury to persons (including
death), or to property or things of whatsoever kind (including, but not without limitation, loss of anticipated profits),
occasioned by or arising out of the installation, operation,
use, misuse, non-use, repair, or replacement of said material and equipment, or out of the use of any method or process for which the same may be employed. The use of this
equipment constitute’s Buyer’s acceptance of the terms set
forth in this warranty. There are no understandings, representations, or warranties of any kind, express, implied,
statutory, or otherwise, (including, but not without limitation, the implied warranties of merchantability and fitness
for a particular purpose), not expressly set forth herein.
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2. About the ProCheck
The ProCheck is a hand-held readout device designed
for use with all soil moisture sensors and environmental monitoring sensors made or sold by Decagon.

Specifications
Accuracy: Determined by the sensor being used
Battery Type: 4 AA
Battery Life: 500-1000 Hours Expected
Connector Type: Stereo Plug (3.5mm)
Memory: 5000 individual readings

Components
• ProCheck Hand-held reader
• Serial Cable
• Manual
Optional - Pigtail adapter
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3. The Buttons
MENU is used to turn on the
ProCheck and cycle through the
menus at the top of the screen. Holding MENU down for 3 seconds will
turn the power off. Pressing MENU
in an annotation/edit screen will return to the previous screen.
SAVE is used to save setting changes
to the instrument and annotate readings.
ENTER is used to choose options
within menus, start readings, and
scroll to the right in an annotation/
edit menu.
ESC is used to cancel setting changes, cancel readings, and scroll to the
left in an annotation/edit menu.
The UP and DOWN arrows are used
to scroll through sensors and menu
options, as well as change characters and numbers in the annotate/edit
menus.
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4. The Menus
The Main Menu
The ProCheck features three main menus designed for
ease of use. The ProCheck displays the Main Menu
when first powered on. This menu is used for taking the
measurements with Decagon’s sensors.

Changing Your Sensor
You can change your sensor type by pressing the up and
down arrow keys if the sensor list spinner is available.
NOTE: You can customize the sensor units and calibrations in the Config. Menu. The sensor version is only shown if the ProCheck was able
to retrieve sensor information directly from the sensor. A soil calibration
type is displayed only if it is available for that sensor type.
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Taking a Reading
To take a reading, scroll through the sensor list until you
find the sensor type you want to read. Plug the sensor
into the stereo jack on the top of the ProCheck.
Press ENTER to start the live update mode. A live updating icon is displayed in the lower right corner. The
ProCheck will continuously update the screen with the
latest sensor reading. Press ENTER again to restart the
sensor. Press ESC to exit the live update mode. Press
SAVE to save the current reading on the display. From
the save screen you may annotate your reading.

Annotating a Reading
Once you have taken a reading, press SAVE to show the
annotation screen. The left side of the screen shows a
reading summary and the right side of the screen shows
the annotation field as well as the date and time the reading was taken.

Use the up and down arrow keys to change the current
character and use the left and right arrows to change the
cursor position. Press SAVE to save the annotation and
MENU to return to the main screen without saving the
record.
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NOTE: The ProCheck will remember the last annotation
stored into memory. You can clear all or part of an old annotation by pressing the up or down arrow key. This will clear all
the characters to the right of the current cursor position.

The Config Menu
To navigate to the Config Menu, press MENU until the
Config tab is highlighted. Several different options are
available for customizing the instrument.
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Units Sub Menu
From this menu you can configure your unit preferences
for various unit types.

Use the up and down arrows to navigate to the unit you
would like to change and press ENTER to cycle through
the different types.
The “Show Unprocessed Data” option allows you to view
any formatted data in its raw analog to digital count (ADC)
state instead. When this option is checked, all data readings on the main and data screens are displayed in an unprocessed format as seen on the following screen. This can
be helpful when troubleshooting sensors or when creating
your own custom calibration. To save your changes, press
SAVE. To cancel without saving, press ESC.
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Calibration Type Sub Menu
Some sensors support a calibration adjustment for different media types (soil, rockwool, etc.). The first screen
shows a summary of the selected soil calibrations for each
configurable sensor.

To modify a sensor’s calibration type, press ENTER. You
can choose a preset soil calibration type or create your
own (See creating a Custom Calibration). To change the
soil calibration type, press ENTER when the medium option is selected. You can view the calibration coefficients
by pressing ENTER when the coefficients option is highlighted. Press SAVE to save your calibration preference or
press ESC to exit without saving changes.

10

ProCheck
4. The Menus

Below is a list of sensors that support soil calibrations.
Sensor Name

Supported Medium Calibrations

EC-20 Soil Moisture

Mineral, Custom

EC-10 Soil Moisture

Mineral, Custom

10 HS Soil Moisture

Mineral, Custom

EC-5 Soil Moisture

Mineral, Potting, Rockwool, Perlite, Custom

ECH2O-TE Moisture,
Temp, EC

Mineral, Potting, Rockwool, Perlite, Custom

EC-TM Moisture, Temp

Mineral, Potting, Rockwool, Perlite, Custom

5TE Moisture, Temp, EC

Mineral, Potting, Rockwool, Perlite, Custom

5TM Moisture, Temp

Mineral, Potting, Rockwool, Perlite, Custom

NOTE: With the 5TE 5TM sensors (only), custum calibration equations must be constructed with ea (dielectric permittivity) as the ‘x’ variable. With the ProCheck and other
Decagon data acquisition equipment, ea = Raw/50. With
other data acquisition equipment, if read in SDI-12 mode,
ea = Raw/100.
Creating a Custom Calibration
You can create your own custom calibration for certain sensor types. A custom calibration is applied directly to the
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raw analog to digital count (ADC) in the form of a fifth
order polynomial. For more information on creating a custom calibration, please refer to the literature section of our
website at www.decagon.com for an Application Note.
NOTE: Custom calibrations are in terms of m3/m3. Unit
conversions are applied after the custom calibration is applied.
Entering a Custom Calibration
To enter your custom calibration into the ProCheck, navigate to the Calibration Type sub menu (in the Config
Menu) and select a sensor. Press ENTER until the medium
type says Custom. Then press ENTER on the coefficient
option to get to a summary screen like the one below.

Each coefficient corresponds to a letter in the polynomial
above. Below the polynomial is the value of each coefficient
in scientific notation. To edit a coefficient, press ENTER
when the desired coefficient is highlighted. You will see a
screen like the one below.

12

ProCheck
4. The Menus

Use the up and down arrow keys to change the current
value, use the left and right arrow keys to change the cursor position. Press SAVE to save the coefficient and MENU
to return to the coefficient list without changing the coefficient.
Once you’ve changed all of the coefficients, press SAVE
again to save the custom calibration or ESC to return to
the Calibration Type sub menu without saving the calibration.

Sensor List Sub Menu
You can customize which sensors you would like available
on your main screen here.

Navigate through the sensor list using the up and down arrows. To change the status of a sensor, highlight it and press
13
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ENTER. If the sensor name is checked, it will be included
in the list on the main screen. If it is unchecked it will
be excluded. You can use the “Check All” or “Un-check
All” options to enable/disable all the sensors at once. Press
SAVE to save your changes or press ESC to exit without
saving.

SDI-12 Address Menu
Intro to SDI-12
SDI-12 stands for serial data interface at 1200 baud. This
standard was created to interface battery powered data
recorders (loggers) with micro-processor based (intelligent) sensors designed for environmental data acquisition
(EDA). Please see www.sdi-12.org for more information
on using SDI-12.
Decagon’s digital soil moisture sensors communicate using both the SDI-12 standard and Decagons proprietary
protocol. This SDI-12 feature is not necessary when using
Decagon sensors with Decagon data loggers. But, SDI-12
may be useful if you are using the sensors with other third
party data acquisition systems such as Campbell Scientific
data loggers.
One feature of the SDI-12 protocol is the use of a single
charactor sensor address. This character may consist of “0”
(default) to 1-9, a-z, or A-Z. This address is necessary when
multiple sensors are installed at a single site. This is important because you will need to assign each sensor a different
address thus allowing you to keep their data separate.
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Setting SDI-12 addresses
The ProCheck may be used to conveniently assign SDI-12
addresses to the Decagon digital sensor. To assign the addresses, follow the instructions below:
1. Use the pigtail adaptor to connect a SDI-12 compatible sensor the the ProCheck’s stereo jack.
2. In the CONFIG menu, select SDI-12 Address. Once
selected the following screen will appear. The screen
will refresh with the sensor’s current configuration.

3. Press the up and down arrows to select the new address from “0” (default) to 1-9, a-z, or A-Z.
4. Press ENTER or SAVE to accept new address. Screen
will refresh showing new address setting.
5. Press ESC or MENU to exit the SDI-12 Address Sub
Menu.
Note: If you plan on setting addresses on multiple sensors,
repeat the steps 1 through 4 before proceeding to step 5.
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Date and Time Sub Menu
To set the date/time on the instrument you can connect
to ECH2O Utility and select the “Set Date/Time” option
under the actions menu, or you can follow the instructions below to manually update the date and time:

1. Scroll to the Date Option in the Config Menu and
press ENTER. You should see a screen similar to the
one above. A pair of arrows will be present above and
below the first value.
2. Use the up and down arrow keys to change the current
value. Press ENTER to move to the next value or press
ESC to return to the previous value. (Hold down the
up/down arrows to scroll quickly).
3. Press SAVE to save your changes.

Contrast Sub Menu
This menu allows you to alter the screen lighting contrast
settings. Scroll to the contrast option in the Config Menu
press ENTER.
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Use the up and down arrows to change the contrast. Press
SAVE to save the contrast or press ESC to exit without saving changes.

About Sub Menu
This menu displays your ProCheck’s serial number, device
name and firmware version.

The Data Menu
To navigate to the Data Menu, press MENU until the Data
Tab is highlighted. Several different options are available
within this menu. With the ProCheck you can store up to
5000 individual readings.

Number of Readings Taken

17
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View Sub Menu
You can view a summary of your saved data or view detailed information about any data record. The first screen is
a summary screen and looks similar to the picture below.

This page shows a data record list that includes the date and
the time that the reading was taken and the annotation (if
any). To view more information about an individual record, press ENTER while that record is highlighted. (See
screen below).

The left side of the screen shows a reading summary and
the right side shows the annotation, date, and time that the
reading was taken. From this screen you can press ESC to
return to the previous view screen or use the up and down
arrow keys to view more records in detail.
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Downloading Data
Your ProCheck comes with ECH2O Utility software for
Microsoft Windows. The Utility makes downloading data
to your computer very easy. In general, you should use the
ECH2O Utility to download data instead of the menu option in the ProCheck.
This menu option sends the data saved in the ProCheck to
the terminal software running on your computer.
1. Configure your terminal software with the following
settings:
• 9600 baud
• 8 data bits, 1 stop bit, no parity
• No software/hardware flow control
• Append line feeds to incoming line ends
2. Connect your ProCheck to an available serial port on
your computer using the included RS-232 serial cable.
3. Set your terminal software to capture received data if
you want to save the data.
4. Select “Download” from the Data Menu of the
ProCheck.
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Erasing Data Memory
WARNING! Once this feature is activated, all data will
be permanently deleted from the ProCheck, and cannot
be recovered.
To erase your data, do the following.
1. Navigate to the Data Menu in the ProCheck.
2. Select the Erase option.
3. Press ENTER on the Erase Data Memory screen.
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5. ECH2O Utility Software
ECH2O Utility is the software interface for downloading
sensor measurment data stored in your ProCheck. You
can choose to save your data as an Excel Workbook file,
tab-delimited text file, and a Raw, unprocessed data file.
ECH2O Utility also helps you delete measurement data
stored in your ProCheck and set the date and time in your
ProCheck.
NOTE: ECH2O Utility is designed to work with your
ProCheck and Decagon’s line of ECH2O loggers. Some of the
controls, features and settings of ECH2O Utility are disabled
when connected to a ProCheck because they don’t apply to your
ProCheck.
Minimum computer requirements:
• Windows 98 or newer, including Windows 7
• Available serial port (or USB-to-serial adapter)
• MS Excel 97 or newer (if saving data as XLS files)
Installation
The ECH2O Utility installer software is located on the
CD-ROM that shipped with your ProCheck instrument.
You can also download the latest version of ECH2O Utility from Decagon’s website: http://www.decagon.com/support/downloads.
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Connecting to your ProCheck
ECH2O Utility needs to establish a communication connection with your ProCheck to perform any of its functions. To connect to your ProCheck, do the following:
1. Launch ECH2O Utility.
2. Use the supplied RS232 serial cable to physically connect your ProCheck to an available serial (COM) port
on your computer. If your computer doesn’t have an
available serial port, you can use an USB-to-serial
adapter.
3. Choose the correct serial (COM) port from the Connect Via control in the toolbar that matches the physical port you chose in step 2.
4. Click the Connect button in the toolbar.
NOTE: if you receive an error tyring to connect to your
ProCheck, please check your serial port choice. Please also see
Chapter 6: Troubleshooting for more serial port help.
Once ECH2O Utility establishjes a connection with the
ProCheck, you should see the ProCheck’s name, serial
number, firmware version and date & timesettings.
1. Connect ECH2O Utility to your ProCheck.
2. Click the Download button in the toolbar. You can also
22
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choose Download All Data from the Data Menu.
3. ECH2O Utility opens a standard File Save dialog. With
this dialog, you can name your data file, select where
it will be saved on your computer, and choose a file
format for the saved data.
4. Click the dialog’s Save button to start the download.
ECH2O Utility will show the progress of your download.
NOTE: You can cancel a download in progress using the Cancel button. ECH2O Utility doesn’t create a data file if you
cancel the download.

Saved Data Filetypes
By default, ECH2O Utility saves measurement data as an
Excel Workbook file. Each of the file types are discussed
below.
Excel Workbook (*.xls): ECH2O Utility saves your measurement data on Sheet 1 with the following columns:
• Measurement Time: Date and time when the 		
ProCheck made the measurement.
• Sensor Name: Type of sensor used for the measure
ment.
• Measurement 1: Primary measurements made by
the sensor.
• Measurement 2: Some sensors support two mea
surements.
• Measurement 3: Some sensors support three mea
surements.
• Sample ID: The optional annotation saved at the
23
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time of measurement.
ECH2O Utility saves the raw data for each measurement
on Sheet 2. This information includes the calibration coefficients used to calculate your data (for applicable sensors). You can use the raw data for the sensor to apply a
different calibration if needed. This sheet has the following
columns:
• Measurement Time: Date and time when the
ProCheck made the measurement.
• Sensor Name: Type of sensor used for the mea
surement.
• Unprocessed 1: Raw data for measurement 1
• Unprocessed 2: Raw data for measurement 2.
• Unprocessed 3: Raw data for measurement 3.
• Sample ID: The optional annotation saved at
the time of measurement.
• Calibration: The calibration used for soil mois
ture sensors.
• Coef a to Coef f: The calibration coefficients
used to calculate the measurement data.
Processed Data Text File (tab delimited)(*.txt): This file
format creates a tab delimited text file of your measurement data. This file type is useful if you don’t have software
that can read Excel files (this format does not contain any
of the raw sensor data). The data are organized in the following columns:
• Measurement Time: Date and Time when the 		
ProCheck made the measurement.
• Sensor Name: Type of sensor used for the measure
ment.
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• Measurement 1: Primary measurement made by
the sensor.
• Units 1: Units for measurement 1.
• Measurement 2: Some sensors support two measure
ments.
• Units 2: Units for measurement 2.
• Measurement 3: Some sensors support three mea
surements.
• Units 3: Units for Measurement 3.
• Sample ID: The optional annotation saved at the
time of measurement.
Raw File (comma delimited) (*.csv): This file format contains just the raw data as stored by the ProCheck. Save this
type of file if you need to send a raw file to Decagon to help
in troubleshooting a data processing problem.

Data File Options
ECH2O Utility has several user preference options that
help you control how your data files are created. These
options only apply to the Excel Workbook and Processed
Data Text file formats. To change these options, open the
ECH2O Utility preferences by choosing Preferences from
the Edit menu.
Measurement Units: You can choose the units ECH2O
Utility uses to present your data. For example, you can
choose °C or °F for temperature measurements. Use the
Measurement tab to set your preferred units. Data units for
data files come from ECH2O Utility preferences, not the
ProCheck settings.
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Column Headers: By default, ECH2O Utility writes column headers to your data file. You can turn this feature
off by deselecting this option in the Data File tab of the
ECH2O Utility Preferences.
Date and Time Formatting in Data Files: ECH2O Utility
uses the Windows operating system settings for formatting
date and time information (Regional & Language Options
control panel). You can override this formatting in the Data
File tab of the ECH2O Utility Preferences.

More ECH2O Utility Options
In addition to downloading data stored in your ProCheck,
ECH2O Utility helps you manage your ProCheck with the
following options.

Setting the Date and Time
ECH2O Utility automatically synchronizes the date and
time of your ProCheck to your computer time when you
connect to your ProCheck. You can manually synchronize
the time by selecting Set Date/Time from the Action menu.

Test Device Firmware
If you think your ProCheck is not operating correctly, you
can check the integrity of the firmware in your ProCheck.
Firmware is the embedded software that controls how your
ProCheck functions. First, establish a connection to your
ProCheck then choose Test Device Firmware from the Device Tools sub-menu in the Actions menu. Contact Decagon or your Decagon representative if your firmware has
become corrupt.
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Check for Device Firmware Updates
You can use ECH2O Utility to check for updates to your
ProCheck firmware. Choose Check for Device Firmware
Updates from the Help menu to compare the firmware
version in your ProCheck with the latest version available
from Decagon. Your computer must be connected to the
internet for this feature to work. Decagon can improve
your ProCheck by publishing new versions of firmware to
fix bugs or add features.
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6. Troubleshooting
This chapter is in two sections. The first section is troubleshooting ideas for resolving issues when using your
ProCheck. The second section is for troubleshooting software issues with ECH2O Utility.

Troubleshooting the ProCheck
To ensure operation of your ProCheck, please consider the
following:
Batteries: Be sure your ProCheck has sufficient battery
power. The ProCheck screen shows a battery icon in the
upper right corner. When the battery power is low, replace
the batteries. You can also use ECH2O Utility to check
your battery power. Make sure you insert the batteries in
the correct orientation when replacing them.
Sensors Plugged Securely: Check that your sensor connector is fully engaged with the connector on the ProCheck.
Correct Sensor Type: Be sure to select the correct sensor
from the sensor menu on the main screen. Making measurements with an incorrect sensor type selected will create
incorrect measurements.

Troubleshooting ProCheck Readings
PROBLEM: My ProCheck says “Above Range or “Below
Range” in the display.
28

ProCheck
6. Troubleshooting

SOLUTION: The ProCheck is reading a value below (or
above) the expected value for the sensor. This could indicate a broken sensor. Check to make sure the sensor is fully
plugged in and the correct sensor type is chosen in the sensor menu.
PROBLEM: My ProCheck says “Invalid Response” or “No
Response” on the display.
SOLUTION: The ProCheck is unable to communicate
with a digital sensor. Check to make sure the sensor is fully
plugged in and the correct sensor type is chosen in the sensor menu. Try pressing the ENTER button several times
to restart the sensor measurement. If these steps fail, the
sensor is probably broken.
PROBLEM: The data shown for my ProCheck doesn’t
seem correct.
SOLUTION: If you are using a custom calibration, be sure
that the coefficients are properly entered in the sensor configure menu. Check to make sure the sensor type shown
in the sensor menu on the main screen matches the sensor
type plugged into the ProCheck. If these steps don’t resolve
the problem, please consult the sensor’s user manual for
more information.
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Troubleshooting ECH2O Utility
Troubleshooting Serial Connections
PROBLEM: The ECH2O Utility tells me the communication port I want to use is in use by another application, but
I don’t think any other programs are running.
SOLUTION: Some PDA synchronization programs monitor serial communication ports. Disable Microsoft’s ActiveSync or Palm’s HotSync system software while trying to
use the serial port with the ECH2O Utility.
PROBLEM: My USB-to-Serial adapter is not showing in
the communication port picker.
SOLUTION: Enable “Force find all Communication
Ports” in the Preferences Menu by going to the Edit Menu,
clicking Preferences, then the Communication tab, and enabling the check box at the bottom of the screen. Enabling
this option may find other serial ports that are not available for use by the ECH2O Utility (for example, modems
installed in your computer).
PROBLEM: ECH2O Utility tells me it can’t connect to
my ProCheck.
SOLUTION: Try one or more of the following to make
sure there is a serial connection to you ProCheck.
• Check your serial port choice. Make sure the “Connect Via” drop-down menu shows the name of the se30
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rial port you are using to physically connect to your
ProCheck. For example, if your ProCheck is physically connected to COM1, the “Connect Via” control
should be set to “Direct on COM1 Communication
Port”.
• Check that your serial cable is securely plugged into
your ProCheck and your computer.
• Make sure your ProCheck has good batteries.
PROBLEM: ECH2O Utility keeps reporting it lost the
connection to my device.
SOLUTION: Please check or replace your serial cables.
You can also increase the number of times ECH2O Utility
tries sending commands to the ProCheck or DataStation.
Increase the Direct Connect Retries on the Communication tab of the Preferences form.

Troubleshooting Data Issues
PROBLEM: ECH2O Utility tells me there is no data for
downloading.
SOLUTION: There is no measurement data stored in your
ProCheck or previously saved data was erased. If you want
to use measurement data collected by the ProCheck on
your computer, be sure to press the SAVE button on the
ProCheck after each measurement.
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PROBLEM: Some of the measurement data in my
ProCheck data file shows “* * *”.
SOLUTION: The three asterisks means the data stored by
the ProCheck is outside the expected range for the sensor
type. This could indicate a broken sensor.
PROBLEM: My sensor data doesn’t seem correct.
SOLUTION: There are many issues that affect the quality of the sensor measurement. Please see the user manual
for your particular sensor for help troubleshooting the data
collected by your sensor.
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Appendix A: Compatible Sensors
Decagon designed the ProCheck to provide a simple measurement interface for the ECH2O soil moisture sensor
family. You can easily make and record instantaneous sensor measurements with the ProCheck.
The ProCheck is also useful when installing and troubleshooting sensors used with the ECH2O loggers. For this
reason, the ProCheck will measure all the sensors used in
the ECH2O system.
NOTE: The ProCheck is only compatible with sensors made
and sold by Decagon Devices for the ECH2O system.

Soil Moisture Sensors (Digital & Analog)
The ProCheck supports using the ECH2O volumetric water content sensor in different types of growth media. The
following table lists the supported calibrations for each
type of sensor.
Sensor Name

Supported Medium Calibrations

EC-20 Soil Moisture

Mineral, Custom

EC-10 Soil Moisture

Mineral, Custom

10 HS Soil Moisture

Mineral, Custom

EC-5 Soil Moisture

Mineral, Potting, Rockwool, Perlite, Custom

ECH2O-TE Moisture,
Temp, EC

Mineral, Potting, Rockwool, Perlite, Custom

EC-TM Moisture, Temp

Mineral, Potting, Rockwool, Perlite, Custom
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5TE Moisture, Temp, EC

Mineral, Potting, Rockwool, Perlite, Custom

5TM Moisture, Tmep

Mineral, Potting, Rockwood, Perlite, Custom

Please see your sensor user manual for more information
on medium-specific and custom calibrations.

Analog Environmental Sensors
The ProCheck is also compatible with the following
ECH2O system analog sensors:
• MPS-1 Water Potential
• ECT Temperature
• PYR Solar Radiation
• QSO-S PAR Photon Flux
•Millivolt

Rain Gauge Sensors
The ProCheck will count tips from the following rain gauge
sensors. This is helpful for troubleshooting rain gauge problems.
• ECRN-50 Precipitation
• ECRN-50 Volume
• ECRN-100 Precipitation
NOTE: The ProCheck is not compatible with the ECRN Precipitation rain gauge used with Em5 loggers.

Digital Sensor
The ProCheck also displays and stores data collected by the
following digital sensor:
•

EHT RH/TEMP (temperature and relative humidity)
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Special Sensors
The following sensors are treated as special cases for the
ProCheck. When an ECH2O logger measures these sensors. It uses a time-series date to make each measurement.
The ProCheck can only take instantaneous measurements
so the data measured by the ProCheck is different from a
logger.
•G1 Drain Gauge shows the percent full of the tip
reservoir.
•LWS (Leaf Wetness Sensor) shows the wetness status.
•Pressure Switch shows if the switch is open or shut.
•Davis Cup Anemometer shows cumulative cup rotations and wind vane angle.
NOTE: Decagon will release firmware updates for the
ProCheck to support any future ECH2O system sensors compatible with the ProCheck. These are available on Decagon’s
website at www.decagon.com/support/downloads and can be
installed by the end user.
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Appendix B: Sending Feedback
Decagon Software makes it easy to send feedback, bug reports, and feature requests to Decagon or your Decagon
Distributor. Choose “Send Feedback to Decagon...” from
the help menu. This opens the window shown below.
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Enter your name, company name, and other contact information. Tell us what type of feedback you are sending
(General Feedback, Feature Suggestions, Bug Report, or
Other). Indicate how you want us to respond to your feedback (E-mail or Telephone).
Use the description area to give details for your feedback.
If you are reporting a bug, it is very helpful for you to tell
us what steps you took for the bug to happen and any error
message you saw. By default, bug reports also include the
software error files.
You can send Decagon a file using this form too. This is
useful for sending data files that you have questions about.
If you work directly with a Decagon representative, put
their E-mail address in the field at the bottom of the form.
This sends the contents of the form to them. Your Decagon
representative can follow-up with you directly.
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ProCheck CE Compliance
DECLARATION OF CONFORMITY
Application of Council Directive:

89/336/EEC

Standards to Which Conformity is
Declared:
EN55022 : 1998

EN61326 : 1998

Manufacturer’s Name:

Decagon Devices, Inc.

Type of Equipment:

ProCheck

Model Number:

PC-1

Year of First Manufacture:

2007

This is to certify that the ProCheck, manufactured by
Decagon Devices, Inc., a corporation based in Pullman, Washington, USA, meets or exceeds the standards
for CE compliance as per the Council Directives noted
above. All instruments are built at the factory at Decagon
and pertinent testing documentation is freely available
for verification.Index
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